User Guide:

Golden Apple Scholars of Illinois Program

Contents:
• An Overview of Program Administration, Page 2
• Access and Navigation, Page 3
• Student Eligibility List, Pages 4 - 11
• Payment Processing, Pages 12 - 26
Golden Apple Scholars of Illinois (GA) Program

Application, Certification and Award Determination

Applications for the Golden Apple Scholars of Illinois Program are accepted and processed by the Golden Apple Foundation, and the program is administered in GAP Access in partnership with the Foundation and the participating colleges that Scholars are attending.

Once the Foundation has evaluated applicants and determined who may be eligible to receive benefits of the GA program, the Foundation provides applicant data to ISAC which is uploaded to GAP Access.

The Foundation then completes the certification process in GAP Access and identifies which applicants are currently meeting eligibility criteria for the program. Colleges do not need to complete the certification process for GA, as is done for the Minority Teachers of Illinois (MTI) Scholarship Program.

For applicants certified as not eligible by the Foundation in GAP Access, one of these indicators will be provided:

- Probation
- Exits
- Not Reporting.

As the Foundation completes the certification process, program awarding is automatically determined based on grade level, applicant category, etc., and the Foundation has the ability to override and adjust an award amount in GAP Access, as needed.

Any changes to certification data after awarding has taken place are made by the Foundation or ISAC.

After the certification and awarding process has been completed, payment functionality will be made available in GAP Access so that colleges can complete the payment request process for awarded students who are enrolled and continuing to meet eligibility requirements at their institution.

The total number of scholarships awarded each year is contingent upon the funds appropriated by the Illinois General Assembly, and the awarding process does not occur until after a final appropriation has been approved by the General Assembly and the Governor.

Payment Processing

Colleges submit payment requests using the GA system in ISAC's GAP Access portal throughout the course of the award year. Payment is made to colleges through an offset process. As part of this process, new payment requests are compared to outstanding amounts owed to ISAC, and payment is made accordingly.
Beginning with the 2019-20 award year, the system to administer the Golden Apple Scholars of Illinois (GA) Program will be available through ISAC’s Gift Assistance Programs (GAP) Access portal at https://isacportal.isac.org.

All users need a valid GAP Access ID and password to access the system.

ISAC relies on a designated Primary Administrator (usually, the Financial Aid Director) at each institution to authorize users and provide them with the appropriate level of access for each ISAC program.

Once a school user has successfully logged in to GAP Access, the GA information can be accessed by selecting the GA program from the Program list.

Please note that the GAP Access system will time out after prolonged inactivity.
GA Student List Eligibility: View

Once you have navigated to the GA Program in GAP Access, you can view the list of applicants provided by the Golden Apple Foundation who may be eligible to receive benefits of the GA program. The list will initially appear in alphabetical order, however, you may use the Filter, Sort and Columns functionality to customize your view as needed.

In addition to the applicant data, the Student List Eligibility: View screen includes the application date, applicant category, certified status, certification date, and award amount. An indicator is also provided if the applicant has been awarded the Minority Teachers of Illinois (MTI) Scholarship Program. (A student cannot receive benefits from both programs in the same academic year.)

Applicants with eligibility or conflict issues will be identified by icons in the List view, and more information can be obtained on the applicant’s Student Detail screen by selecting the magnifying icon in the first column of the student record.

A yellow lightbulb 🕯️ is an indicator of student eligibility issues, and a red triangle ⚠️ is an indicator of a conflict issue.

School Administration Programs

GA 2019-2020: Student List Eligibility: View

UNIVERSITY 00

Entries displayed 20

<table>
<thead>
<tr>
<th>#</th>
<th>Sel</th>
<th>Current SSN</th>
<th>Last Name</th>
<th>First Name</th>
<th>DOB</th>
<th>Default</th>
<th>Total Units</th>
<th>Application Date</th>
<th>Applicant Category</th>
<th>School Code</th>
<th>Academic Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>xxx-xx-4950</td>
<td>HWDEGHTHJ</td>
<td>CWSDDDFF</td>
<td>07/19/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Freshman</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>xxx-xx-4956</td>
<td>HWDEWEEE</td>
<td>CWDFDDDD</td>
<td>08/19/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Freshman</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>xxx-xx-4959</td>
<td>KQAWVGFVGSBB</td>
<td>BQWERDDDFF</td>
<td>08/22/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Senior</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>xxx-xx-4992</td>
<td>KSDFGTHH</td>
<td>SEDFGRFF</td>
<td>07/20/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Sophomore</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>xxx-xx-4956</td>
<td>KWAUTYII</td>
<td>BTTFFGGRE</td>
<td>07/22/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Senior</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>xxx-xx-4957</td>
<td>KSDFGDDWIVW</td>
<td>SWERTQQQ</td>
<td>08/20/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Sophomore</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>xxx-xx-4968</td>
<td>LSDGFGTTTTT</td>
<td>PSDFFFFF</td>
<td>08/21/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Junior</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>xxx-xx-4951</td>
<td>LWASFFGJJJK</td>
<td>PGHFFGGO</td>
<td>07/21/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Junior</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>xxx-xx-4970</td>
<td>NEDFDDDFOOPP</td>
<td>GEDFGGDDDD</td>
<td>08/23/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely Nerv</td>
<td>001692</td>
<td>Freshman</td>
</tr>
</tbody>
</table>
### GA Student List Eligibility: View

**Initial default view:**

<table>
<thead>
<tr>
<th>#</th>
<th>Set</th>
<th>Current SSN</th>
<th>Last Name</th>
<th>First Name</th>
<th>DOB</th>
<th>Default</th>
<th>Total Units</th>
<th>Application Date</th>
<th>Applicant Category</th>
<th>School Code</th>
<th>Academic Level</th>
<th>Certified Eligible</th>
<th>Certified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>☑️</td>
<td>xxx-90-9530</td>
<td>HWDEGHUH</td>
<td>CWSDKDFH</td>
<td>07/16/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>☑️</td>
<td>xxx-90-9566</td>
<td>HYDGFVEEE</td>
<td>CYWDFGDDD</td>
<td>08/19/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>☑️</td>
<td>xxx-90-9589</td>
<td>KQAWFEGVGB</td>
<td>BQWERDDDF</td>
<td>08/22/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Senior</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>☑️</td>
<td>xxx-90-9552</td>
<td>KSDFDGHHH</td>
<td>BESDFGDRFF</td>
<td>07/20/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Senior</td>
<td>001692</td>
<td>Sophomore</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>☑️</td>
<td>xxx-90-9596</td>
<td>KWAUUTYII</td>
<td>BITTFGGGRE</td>
<td>07/22/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Senior</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>☑️</td>
<td>xxx-90-9598</td>
<td>KWSDFGQWWY</td>
<td>SWERTQGQ</td>
<td>09/20/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Senior</td>
<td>001692</td>
<td>Sophomore</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>☑️</td>
<td>xxx-90-9596</td>
<td>LSDKGDSITT</td>
<td>PSDKFFFT</td>
<td>08/21/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Junior</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>☑️</td>
<td>xxx-90-9551</td>
<td>LWABFGJJK</td>
<td>PGHFGGGG</td>
<td>07/21/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Junior</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>☑️</td>
<td>xxx-90-9570</td>
<td>NEBDFDDDOOP</td>
<td>CHDFGHDDD</td>
<td>08/23/2001</td>
<td>N</td>
<td>0</td>
<td>09/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**View when scrolled to the far right, which includes the award amount column:**

<table>
<thead>
<tr>
<th>First Name</th>
<th>DOB</th>
<th>Total Units</th>
<th>Application Date</th>
<th>Applicant Category</th>
<th>School Code</th>
<th>Academic Level</th>
<th>Certified Eligible</th>
<th>Certified Date</th>
<th>Ineligible Reason</th>
<th>Annual Award Amount</th>
<th>Awarded MTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDDFF</td>
<td>07/16/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>DFDDDD</td>
<td>08/19/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>MYHDDDDDD</td>
<td>08/22/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>YSGGGGG</td>
<td>07/20/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>FFGGGRG</td>
<td>07/22/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>ERTQGGG</td>
<td>08/20/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>KFFFGGG</td>
<td>08/21/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>KFFFGGG</td>
<td>08/22/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
<tr>
<td>KFFFGGG</td>
<td>08/23/2001</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td>0</td>
<td>Freshman</td>
<td>0</td>
</tr>
</tbody>
</table>
GA Student List Eligibility: View, continued

GA 2019-2020: Student List Eligibility: View

JNIVERSITY 001

Home  Student  Payment

Filter  Sort  Columns

Entries displayed 20

<table>
<thead>
<tr>
<th>Name</th>
<th>DOB</th>
<th>Degree</th>
<th>Total Units</th>
<th>Application Date</th>
<th>Applicant Category</th>
<th>School Code</th>
<th>Academic Level</th>
<th>Certified Eligible</th>
<th>Certified Date</th>
<th>Ineligible Reason</th>
<th>Annual Award Amount</th>
<th>Awarded MTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOFFF</td>
<td>07/19/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LFDDLDD</td>
<td>08/19/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>VREDDDFDD</td>
<td>08/23/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Senior</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>FGGRFFFF</td>
<td>07/20/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Sophomore</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>FFGGRE</td>
<td>07/22/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Senior</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>ERTQQQQQ</td>
<td>08/20/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Sophomore</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>FFFFFF</td>
<td>08/21/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Junior</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>HFGGGG</td>
<td>07/21/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Junior</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>JFGDDDDDD</td>
<td>08/23/2001</td>
<td>N</td>
<td>0</td>
<td>08/27/2019</td>
<td>Timely New</td>
<td>001692</td>
<td>Freshman</td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

One of the following indicators will be provided for students who have been certified by the Foundation as not eligible:
- Probation
- Exits
- Not Reporting

The award amount will be automatically populated once the Foundation certifies the student as eligible, and the Foundation has the ability to override and change the award amount, as needed.

Depending on your computer, monitor, and screen settings, you may need to use the horizontal scroll bar at the bottom of the page to navigate farther to the right to see these columns on the Student List Eligibility: View screen.
GA Student Eligibility List: Filter Screen

You may filter student records by selecting specific categories provided on the Student Eligibility List: Filter screen, which can be accessed by selecting the Filter tab.

Once you have selected your criteria from the drop down menus and/or selected the category options on the right side of the screen, select the List tab (located to the left of the Filter tab) to generate your customized view.

A Reset tab is also available to clear multiple selections with one click.
The Student Eligibility List: Sort screen provides you with several options for sorting the student list. This screen is accessed by selecting the Sort tab.

To sort your list, check the box next to the data element(s) you would like to sort by, then select the Add arrow to add them to the Selected list. Use the Move Up arrow to put the data elements in the order in which you would like the list to be sorted.

You can also drag and drop your selection(s) into the Selected or Unselected column.

Selected checkboxes will be sorted in descending order. Unchecked checkboxes will be sorted in ascending order.

Once you’ve made all of your sorting selections, click on the List tab (located to the left of the Filter tab) to generate your customized list.

A Reset tab is available to clear multiple selections with one click.
GA Student Eligibility List: Columns Screen

The Student Eligibility List: Columns screen allows you to select the columns you want to view and customize the order in which they appear. This screen is accessed by selecting the Columns tab.

To select a Column for your customized list, click on the column heading to highlight it and then the Add arrow to add it to the Selected list.

Similarly, to remove a column from the List view, select the Column heading in the Selected list and then click on the Remove arrow to add it to the Unselected list.

Use the Move Up and Move Down arrows to put the columns in the order in which you would like them to appear on the List screen.

You can also drag and drop your selection(s) into the Selected or Unselected column.

Once you’ve made all of your selections, click on the List tab (located to the left of the Filter tab) to generate your customized list. A Reset tab is also available to clear multiple selections with one click.
These data elements indicate if an applicant is a Deferred Scholar or a Pathways Scholar.

- **Deferred Scholar** is one who was not inducted as a Golden Apple Scholars of Illinois Program incoming freshman. The scholar, providing he/she maintains eligibility and is inducted, may receive the deferred freshman award amount, in addition to his/her sophomore award amount.

- **Pathway Scholar** is one who enters the program as either a sophomore or junior in college. These scholars are entitled to either two or three years of benefit, accordingly.
GA Payment Processing

GA payment processing is done using the GA system available through ISAC’s Gift Assistance Programs (GAP) Access portal.

GA payment processing can be accessed by selecting **GA** under the **Programs** tab near the top of the screen. Program functions are contingent upon each user program privileges. The administrator must access the User Maintenance area and update the program access and level for each user.

- “None” will grant you zero access to GA data.
- “Update” will grant you the ability to both edit and view GA data.
- “View” will grant you the ability to only view GA data (i.e., no editing ability)

After completing the payment request process in GAP Access, payment is made to colleges through an offset process. As part of this process, new payment requests are compared to outstanding amounts owed to ISAC, and payment is made accordingly. This system was developed to accommodate the many changes in student eligibility that can occur during the awarding and disbursement of financial aid (including decreases, increases to awards, initial requests, and full refunds). Therefore, funds should be returned to ISAC only after a final reconciliation has been completed at the end of the regular school year. All schools with an outstanding amount owed to ISAC at the end of the school year receive a notice indicating the total amount to be returned.

Information about the payment offset process and reconciliation is located on the Refunds and Unpaid Claims page in the Processes area of the FAA section at isac.org.
# Student Payment List: View Screen

The **Student Payment List: View** screen gives the user the ability to easily select students to view payment-related items such as payment request amounts, payment result amounts, and payment result codes at a glance. It operates like the **Student List Eligibility: View** screen, allowing the user to select students who are attending their school and to filter and sort the list according to specific criteria.

The initial loading of this page will result in a default view with the following columns:

- Sel (Select)
- Req Sel (Req Select)
- Term
- Current SSN
- Last Name
- First Name
- Annual Award
- Requested Amount
- Term Award
- School Code
- Request Code *
- Enrollment Status *
- Ineligible Reason *
- Amount Paid
- Adjusted Amount
- Result Code *
- Expanded Result
- Result Date
- Status Code *
- Invoice Number
- Awarded GA

* All codes can be found at the end of the user guide.

Schools can create a customized **Student List Payment: View** screen by selecting specific columns to be viewed, as well as use data sorting and filtering.

The **Student Payment List: View** is accessed by selecting the **Payment** tab. The following functions are available on the **Student List Payment: View** screen: View, Filter, Sort, Columns, Payment Request Entry and Submit Payment Requests.

![Student Payment List: View Screen](image)

---

March 2020
Check the boxes in the **Req Sel** column to select students for payment. Save your selections by clicking on the **Save Selected** button at the bottom of the page.
Payment Eligibility List: Filter Screen

The Filter screen provides many different options for filtering the **Student List Payment: View** screen. Users can change the records to be viewed on the **Student List Payment: View** screen by setting specific criteria for one or more of the options on the **Filter** screen.

For the **Ineligible** options, if more than one is checked a record must meet all conditions to be included in the filtered view.

Click on the Reset button to reset the data to the default values.
Payment Eligibility List: Sort Screen

This screen allows the user to sort the designated columns on the Student List Payment: View screen by something other than the defaulted view of sorting by last name.

For example, the user may select to sort by Enrollment Status. To do so, highlight the column title in the Unselected list of options and click on the arrow pointing to the right.

This will add it to the Selected columns. Then, use the up arrow to move Enrollment Status to the top of the Selected columns. Click on the View tab and you will see a list sorted by Enrollment Status. If the checkboxes next to the Selected columns are checked, the list will be sorted in descending order. If the boxes are left unchecked, the list will sort in ascending order.

To remove a column from the Selected sort list, highlight the column title and then click on the arrow pointing to the left to move it to the Unselected list.

To move all Unselected columns to the Selected list, click on

To clear the entire Selected list, click on
Payment Eligibility List: Columns Screen

This screen allows you to select which columns will be displayed on the **Student List Payment: View** screen, and the order in which they will appear.

To add columns to the **Selected** list, highlight the column title in the **Unselected** list and click the right arrow to send it to the **Selected** list. To remove a column from the **Selected** list, highlight it and click the left arrow to move it to the **Unselected** list.

If you want to re-arrange the columns once they are selected, highlight the desired column and move it by clicking on the up or down arrows until it is in the desired location in the list.

When you click on the **View** tab, the columns will display in the order in which they appear in the **Selected** list.

To move all **Unselected** columns to the **Selected** list, click on

To clear the entire **Selected** list, click on

![Image of Payment Eligibility List: Columns Screen](image_url)
Student Detail: Payment Screen

Individual Payment Requests

The **Student Detail: Payment** screen is a multi-purpose screen that allows schools to view payment information or to create or make adjustments to payment requests for an individual student record. This screen is accessed by clicking on the dollar sign icon that is on the same line as the student’s last name on the **Student List Payment: View** screen and by selecting the **Payment** tab from the **Student Detail: Eligibility** screen.

In addition to the **Payment** tab, the **Student Detail: Payment** screen contains the following navigation tabs:

- **List** – to return to the **Student List Payment: View** screen
- **Eligibility** -- to navigate to the **Student Detail: Eligibility** screen

To navigate to another student, enter the student’s SSN in the **Current SSN** field and click on the **Go** button.
Student Detail: Payment Screen

When requesting payment from the Student Detail screen, there are three required fields:

- **Request**
- **Enrollment Status**
- **Requested Amount** (To adjust the system-calculated annual award amount if necessary)
  
  - The maximum award amount per regular school year is $5,000.
  - Any adjustments to the academic level during an award year can potentially change the term award. Example: sophomore to junior level.
  - The Golden Apple Foundation certifies recipients eligibility one term at time. Only the term(s) that have been certified will be available for payment.
  - Because the Golden Apple Foundation completes certification for Golden Apple recipients, any adjustment to a student’s academic level during the award year that would impact a student’s award amount must be reported to the Golden Apple Foundation so that they can update the student’s certification record. Once the certification record has been updated, the school will be able to submit a payment request for the updated award amount. **The contact person at the Foundation is Cheryl Flores at flores@goldenapple.org.**

Each of these fields must be completed with the appropriate information for payment requests to be processed properly. If the student is ineligible an **Ineligible Reason** must be selected and a and a zero ($0) should be entered in the Requested Amount field.

Click on the **Save Changes** button to save the payment request, or the **Discard Changes** button to discard the payment request.

As a reminder, the payment request process is not complete until the next step of submitting the payment requests to ISAC has been completed using the **Submit Payment Requests** screen.

To navigate to another student, enter the student’s SSN in the **Current SSN** field and click on the **Go** button.
Student Detail: Payment Screen

GA Ineligible Reason
Select the appropriate reason that makes student ineligible.

- Not enrolled *
- Not a US citizen/eligible non-citizen
- Not an Illinois resident
- Not a HS grad/no GED
- Defaulted student loan
- Conflicting scholarship
- Not making satisfactory academic progress
- Reached max number of years allowed
- Not a minority
- GPA not at least 2.5 on 4.0 scale (soph or above)
- Not enrolled at least half-time *
- Student is not accepting MTI
- Not enrolled in a teacher program
- Not registered with Selective Service

* If an Ineligible request is submitted, all payment for the term will be canceled, unless it is for the reason “Not enrolled” or “Not enrolled at least half-time” in Semester 1 or Quarter 1 or 2.
When creating benefit requests for a large number of students, the best option is to do a batch request, which is done by selecting students from the Student Payment List: View screen.

The first step on the Payment Request Entry screen is to select the appropriate academic term using the drop-down box in the Term field (initially blank) for which you will be creating payment requests.

A list of your selected records will not display until you have selected a term.

Once a term has been selected, the list of students you selected on the Student Payment List View for that term will be provided, and you can then begin to enter payment information.
Payment Request Entry

To complete the payment request for each student, enter the required data into the appropriate fields:

- **Request** – Select the appropriate item from the drop-down menu options:
  - “Payment” to create a payment request
  - “Delete” to delete a request that has been created but not yet submitted
  - “Ineligible” to make a student ineligible
  - “Cancel” to cancel a previously requested award

- **Enrollment Status** – Enter full time or half time status

- **Ineligible Reason**- If the student is ineligible an Ineligible Reason must be selected and a zero ($0) should be entered in the Requested Amount field.
  - Note: If an Ineligible request is submitted, all payment for the term will be canceled, unless it is for the reason “Not enrolled” or “Not enrolled at least half time” in Semester 1 or Quarter 1 or 2.

Click the **Save** button to save your data before navigating to a new page.

As a reminder, the payment request process is not complete until the next step of submitting the payment requests to ISAC has been completed using the **Submit Payment Requests** screen.
Submit Payment Requests Process

The **Submit Payment Requests** screen allows the user to submit payment requests to ISAC for processing. The user can specify which payment request records will be submitted based on **Term** selected.

This screen is accessed by selecting the **Submit Payment Requests** tab. After payment requests have been submitted by clicking on the **Submit** button, a message will be displayed indicating how many payment requests were submitted.

To **submit** payment requests to ISAC for GA payment follow these steps:

– Choose the **Term** for which the request is being made from the drop-down menu.
– Click on the **Submit** button to submit the payment request.
– Ensure that a submission message is received and make note of the number of records submitted.
Payment Reports

All payment results, for processing done through the GA system, can be obtained at various stages in the payment request process through system-generated reports. To create a report, navigate to the Reports tab, and then click on the Create New Report.

The Select Report drop down menu is displayed below. To select a report, highlight the title and click on the Request Report button. Data range fields will then be provided to allow you to enter start and end dates for the report. The date fields are optional fields, and if left blank, the report will be cumulative.
Payment Reports

After requesting a report, you will be returned to the **Reports** screen where a list of reports that have been or are being generated for your school will be provided.

While the report is processing, the status will indicate **In Queue**. The refresh button completes the report. When it is ready, the status will change to **Completed**. To open the report, click on either the Microsoft Word or the Microsoft Excel icon. Additional information about the report, including the date, file size and user name of the person who requested the report will also be listed.

Reports displaying the pdf icon 📄 are ISAC-generated reports and identifiable by the user name **GAInvoice** in the last column of the report list. Typically, this report is made available on the next business day after your school’s payment request has been processed and will remain available if space allows. It is suggested that you save requested and the Payment Results/Exceptions report to your systems for future reference.

---

**GA Reports: Eligibility Reports**

![Image of Reports screen]

- Status: Completed
- Date: 10/09/2019
- File Size (kb): 6.154
- User Name: 10/09/2019 12:20:28
Payment Results Summary/Invoice Detail

A Payment Results Summary and Invoice Detail Report is generated by ISAC after your school’s payment request has been processed. It will include a Payment Results Report and a Payment Exceptions Report, as well as Invoice Detail about the payment claim. Typically, the report will be provided in the reports section on the next business day after the request has been processed by ISAC. This report is needed to match the voucher/invoice number and payment.

The Payment Results Summary and Invoice Detail will appear on the report list and can be identified by the pdf icon in the first column and the user name of GAInvoice in the last column.

The last page of this report provides invoice information, including amount due to the school and the invoice number.

ISAC authorizes a voucher in the amount of the payment invoice and submits it to the State Comptroller’s Office which issues payment to the institution. Vouchers are emailed to the Financial Aid Director. The invoice number will be referenced on the voucher authorizing payment from the State Comptroller. Colleges can match the invoice number on the Payment Results/Exceptions report with the voucher.
## GA Codes

<table>
<thead>
<tr>
<th>Result Code</th>
<th>Expanded Result Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td></td>
<td>Ineligible for payment due to due to ISAC Default</td>
</tr>
<tr>
<td>F</td>
<td></td>
<td>Full GA units already used</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Request superceded by another request</td>
</tr>
<tr>
<td>J</td>
<td></td>
<td>Ineligible for payment due to calculated award amount of zero</td>
</tr>
<tr>
<td>G</td>
<td>Y</td>
<td>Full annual award amount already used</td>
</tr>
<tr>
<td>G</td>
<td>P</td>
<td>Full program award maximum already used</td>
</tr>
<tr>
<td>H</td>
<td></td>
<td>Previously paid to your school for requested term</td>
</tr>
<tr>
<td>U</td>
<td></td>
<td>Cancel requested; no prior payment has been made for this term</td>
</tr>
<tr>
<td>Q</td>
<td>Y</td>
<td>Ineligible reason processed - not eligible for this academic year</td>
</tr>
<tr>
<td>Q</td>
<td>T</td>
<td>Ineligible reason processed - not eligible for this term</td>
</tr>
<tr>
<td>R</td>
<td>Y</td>
<td>Payment reduced to maintain GA annual award amount limit</td>
</tr>
<tr>
<td>R</td>
<td>P</td>
<td>Payment reduced to maintain GA program maximum award amount</td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>With this payment student attains the maximum number of terms. Student will no longer be eligible for GA payment</td>
</tr>
<tr>
<td>B</td>
<td></td>
<td>Payment increased</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>Payment decreased</td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>Payment processed - no reported exception</td>
</tr>
<tr>
<td>Y</td>
<td></td>
<td>Annual maximum</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td>Program maximum</td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>Term maximum</td>
</tr>
</tbody>
</table>

### Request Code

<table>
<thead>
<tr>
<th>Request Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Payment</td>
</tr>
<tr>
<td>C</td>
<td>Cancel</td>
</tr>
<tr>
<td>I</td>
<td>Ineligible</td>
</tr>
<tr>
<td>D</td>
<td>Delete</td>
</tr>
</tbody>
</table>

### Status Code

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>Updated</td>
</tr>
<tr>
<td>S</td>
<td>Submitted</td>
</tr>
<tr>
<td>P</td>
<td>Payment</td>
</tr>
</tbody>
</table>

### Enrollment Status Code

<table>
<thead>
<tr>
<th>Enrollment Status Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Half-time</td>
</tr>
<tr>
<td>F</td>
<td>Full-time</td>
</tr>
</tbody>
</table>